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Chapter 1. Introduction to FAStT MSJ 

This chapter introduces the IBM Fibre Array Storage Technology Management Suite 
Java (FAStT MSJ) and includes information on what is contained in this document, 
background information on Storage Area Network (SAN) environments, and an over-
view of the functions of FAStT MSJ. 

About this document
This document contains the latest information available regarding FAStT MSJ, IBM’s 
cross-platform SAN management solution. This guide is intended for trained service 
personnel who are familiar with IBM SAN products and are proficient with Linux, 
Microsoft® Windows®, and NetWare operating system administration. 

Use this document to:

• Understand the SAN environment

• Get an overview of FAStT MSJ 

• View FAStT MSJ system requirements

• Install and start FAStT MSJ

• Explore the features and functions of FAStT MSJ

Note: Read the file README.TXT first. The README file is located in the IBM 
FAStT MSJ folder of the installation CD, or refer to http://www.ibm.com/pc/sup-
port for the latest installation and user information about FAStT MSJ.

The SAN environment
Storage Area Network (SAN) is a high-speed subnetwork of shared storage devices. 
In a typical SAN environment, a system might be equipped with multiple host bus 
adapters (HBAs) that control devices on a local loop or on a fabric (a fabric is the net-
work of Fibre Channel hubs, switches, and gateways connecting storage devices such 
as disk arrays, optical disks or tape libraries, and servers on a many-to-many basis).

In a SAN, a single device can be monitored and controlled by more than one HBA. An 
example of this type of configuration is dual-path devices used in a primary/failover 
setup.

The following are the common basic SAN configurations: 

• Basic storage partitioning

• Cluster and non-cluster shared storage pool

• SAN with partitioned storage

• High-capacity storage configuration

• Multiple clusters in a switched fabric environment

• Direct attach multiple cluster configuration

In a switched or clustering configuration, more than one system can access the same 
device; this type of configuration enables storage sharing. In this scenario, a system 
might access certain logical unit numbers (LUNs) on a device while other systems 
control other LUNs on the same device.
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Because a SAN has scalable storage capacity, you can add new devices dynamically. 
After you add these new devices, they need to be configured. Furthermore, a SAN 
can change not only through the addition of new devices, but also through the 
replacement of current devices on the network. 

In such a complicated environment where there might be hot-swapping of SAN com-
ponents, some manual configuration is required to achieve proper installation and 
functionality. 

Overview of the IBM FAStT Management Suite Java
FAStT MSJ assists you in configuring a SAN environment. This application is specifi-
cally designed for IBM FAStT Fibre Channel HBAs in a SAN environment.

A complete SAN is comprised of HBA components, storage devices, and host sys-
tems, and FAStT MSJ.

FAStT MSJ is a network-capable application that can connect to and configure remote 
systems. The networking capability of FAStT MSJ enables centralized management 
and configuration of the entire SAN.

You can use IBM FAStT MSJ to manage and control one or more IBM FAStT Host Bus 
adapters that are installed on local or remote computers. You use IBM FAStT MSJ, in 
conjunction with problem determination procedures (PDPs), on new or existing instal-
lations to assist in diagnosing Fibre Channel (FC) subsystem problems (in adapters, 
controllers, and devices that are attached to the FC fabric or loop).

With FAStT MSJ you can also configure devices in your system using the following 
three types of operations:

Disable (unconfigure) a device on a host bus adapter
When a device is set as unconfigured by the utility, it is not recognized by the 
HBA and is inaccessible to that HBA on that system.

Enable a device
This operation adds a device and makes it accessible to the HBA on that sys-
tem.

Designate a path as an alternate or preferred path
When a device is accessible from more than one adapter in the same system, 
you can assign one path as the preferred path and the other path as the alter-
nate path. If the preferred path fails, the system switches to the alternate path 
to ensure that data transfer is not interrupted.

Note: The diagnostic functions of FAStT MSJ are available for all supported operat-
ing systems. The configuration functions are available only for the Linux oper-
ating systems. IBM FAStT Storage Manager provides management capability 
for Microsoft Windows and NetWare-based platforms. 
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Chapter 2. FAStT MSJ system requirements

The FAStT MSJ application consists of two components:

• FAStT MSJ client interface

• Host agent

Each of these components has different system requirements depending on the oper-
ating system that they run on.

FAStT MSJ client interface
FAStT MSJ is written in Java and should run on any platform that has a compatible 
Java VM installed. The minimum system requirements for FAStT MSJ to run on all 
platforms are: 

• A video card capable of 256 colors

• At least 64 MB of physical RAM (128 MB is preferred. Running with less memory 
might cause disk swapping, which has a negative effect on performance.)

• 30 MB of free disk space is required for installation

Platform-specific requirements for the FAStT MSJ client interface are as follows:

• Linux x86

— RedHat Linux 7.1 (preferred configuration)

— PII 233MHz (preferred minimum)

• Microsoft Windows 2000/Windows NT

— Pentium III processor 450 MHz or greater

• Novell NetWare

— Pentium III processor 450 MHz or greater

Note: If multiple Network Interface Cards (NICs) are present in the system, the 
FAStT MSJ client will broadcast to the first IP address subnet based on the 
binding order. Therefore, ensure that the NIC for the local subnet is first in the 
binding order. If this is not done, the diagnostics might not run properly and 
remote connection might not occur. See the Readme file in the release pack-
age for more information.

Host agent
Host agents are platform-specific applications that reside on a host with IBM HBAs 
attached. The minimum system requirements for an agent to run on all platforms are:

• An IBM FAStT MSJ-supported driver (see release.txt in the release package for a 
list of supported device driver versions for each platform)

• At least 8 MB of physical RAM

• 2 MB of free disk space is required for installation

Platform-specific requirements for the FAStT MSJ host agents are as follows:

• Linux x86—Agent runs as a daemon

• Microsoft Windows NT® or Windows 2000—Agent runs as an NT service

• Novell NetWare installation prerequisites
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Be sure you have the following items before installing the QLremote NetWare 
Agent:

— NetWare Client software (from Novell) on the Windows NT/2000 client

— NWLink IPX/SPX-compatible transport or TCP/IP transport network protocols

Note: The TCP/IP transport must be loaded to communicate with the FAStT 
MSJ agent. 

— NWLink NetBios

— Drive letter mapped to the root of the SYS volume of the NetWare server. By 
default, the NetWare Client maps to sys\system or sys\public; however, you 
must set the root of SYS volume by assigning a drive letter to sys:\.

Note: You must be logged on as an administrator to map server drive letters.

— On the NetWare Server—NetWare 5.1 server with service pack 2 or later 
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Chapter 3. Installing and getting started

This chapter contains procedures for installing FAStT MSJ and for using the applica-
tion.

Installing and uninstalling FAStT MSJ
This section discusses the following:

• Initial installation options

• Installing FAStT MSJ

• Uninstalling FAStT MSJ

Initial installation options
FAStT MSJ supports stand-alone and network configurations. Install the software 
appropriate for your configuration. See Table 1 for details.

Note: The same version of FAStT MSJ must be installed on all systems.

Installing FAStT MSJ
The FAStT MSJ installer is a self-extracting program that installs the FAStT MSJ appli-
cation and related software.

Notes:

1. If you have a previous version of FAStT MSJ installed, uninstall the previous ver-
sion of FAStT MSJ before installing FAStT MSJ.

2. You cannot install the FAStT MSJ agent directly on a NetWare server; you must 
install the agent on a system connected to the NetWare server. The Netware 
server must have a drive mapped to a Windows 2000 or Windows NT system. 

Table 1. Configuration option installation requirements. 

Configuration Software Requirements

Stand-alone system: This system monitors 
host bus adapters locally. 

FAStT MSJ GUI

Plus one of the following:

• FAStT MSJ NT/2000 agent

• FAStT MSJ Linux agent

Networked system: This system monitors 
host bus adapters locally and monitors remote 
systems on the network. Host agents are 
required for remote connection (see "Host 
agent system" following).

FAStT MSJ GUI

Plus one of the following:

• FAStT MSJ NT/2000 agent

• FAStT MSJ Linux agent

Client system: This system monitors host bus 
adapters only on remote systems on the 
network.

FAStT MSJ GUI

Host agents (see requirements for host 
agent system)

Host agent system: The host bus adapters 
on this system are remotely monitored only 
from other systems on the network.

One of the following:

• FAStT MSJ NT4/2000 agent

• FAStT MSJ NetWare 5.x agent

• FAStT MSJ Linux agent
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Perform the following steps to install FAStT MSJ on the system or the NetWare server:

1. Access the FAStT MSJ installer by doing one of the following:

• If installing FAStT MSJ from a CD, click the IBM FAStT MSJ folder on the CD.

• If installing FAStT MSJ from the IBM Web site, go to the page from which you 
can download FAStT MSJ (this URL is listed in the README file).

2. From the CD folder or the folder in which you saved the FAStT MSJ installer, 
select the appropriate install file by doing one of the following:

• For Windows 2000/Windows NT and NetWare, double-click the 
FAStTMSJ_install.exe file.

Note: For NetWare, save to the system drive mapped to the NetWare server.

• For Red Hat Linux, do the following:

a. Open a shell.

b. Change to the directory that contains the FAStT MSJ installer that you 
downloaded in Step 1.

c. At the prompt, type sh ./FAStTMSJ_install.bin, where install is the 
FAStT MSJ installer file.

InstallAnywhere prepares to install FAStT MSJ. The Installation Introduc-
tion window is displayed. 

3. Click Next. The Choose Product Features window is displayed. The window dif-
fers, depending on whether you are installing on a Windows 2000/Windows NT, or 
Red Hat Linux system. See Figure 1 for a sample window.

Figure 1. Choose Product Features window (sample)

4. Do one of the following to install the software appropriate to your configuration:

• For Windows 2000/Windows NT systems, click one of the following preconfig-
ured installation sets, then click Next.

— Click GUI and NT Agent if this Windows 2000/Windows NT system will 
monitor host bus adapters on this system and remote systems on the net-
work.
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— Click GUI if the system will monitor host bus adapters only on remote sys-
tems on the network.

— Click NT Agent if the host bus adapters on this Windows 2000/Windows 
NT system will be remotely monitored only from other systems on the net-
work.

— Click NetWare 5.x Agent if the host bus adapters on this NetWare 5.x 
system will be remotely monitored only from other systems on the net-
work.

• For Red Hat Linux systems, click one of the following preconfigured installa-
tion sets, then click Next.

— Click GUI if the system will monitor host bus adapters only on remote sys-
tems on the network.

— Click Linux Agent if the host bus adapters on this Red Hat Linux system 
will be remotely monitored only from other systems on the network.

— Click GUI and Linux Agent if this Red Hat Linux system will monitor host 
bus adapters on this system and on remote systems on the network.

• For other configuration installation sets, click Customize to create a custom-
ized installation set. The Choose Product Components window is displayed. 
The window differs depending on whether you are installing on a Windows 
2000/Windows NT or Red Hat Linux system.

Perform the following steps to create a custom installation set:

a. In the Feature Set list-box, click Custom Set.

b. Select from the following components:

— For a Windows 2000/Windows NT system:

– GUI

– NT Agent

– NetWare 5.x Agent

– Help

— For a Red Hat Linux system:

– GUI

– Linux Agent

– Help

c. Click Next. The Important Information window is displayed.

5. Read the information, then click Next.

Note: Information in the README file supplied with the installation package 
takes precedence over the information in the Important Information win-
dow.

The Choose Install Folder window is displayed.

6.  Do one of the following:

Note:  For NetWare, click the drive mapped to the NetWare server.

• To select the default destination location displayed in the window, click Next.

The default location for a Windows 2000/Windows NT system is C:\Program 
Files\IBM FAStT Management Suite\ .

The default location for a Red Hat Linux system is /root/IBM_FAStT_MSJ.

• To select a location other than the default, click Choose, click the desired 
location, and click Next.
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• To reselect the default location after selecting a different location, click 
Restore Default Folder, and click Next

7. If you are installing on a Windows platform, the Select Shortcut Profile location 
window is displayed. Do one of the following:

a. To select the all users profile to install the application program group and 
shortcuts, select the All Users Profile radio button, and click Next.

b. To select the current users profile to install the application program group and 
shortcuts, select the Current Users Profile radio button, and click Next.

8. If you are installing on a NetWare system, the Novell NetWare Disk Selection win-
dow is displayed (see Figure 2).

Figure 2. Novell NetWare Disk Selection window

A list of the autodetected, mapped NetWare drives on the subnet is displayed in 
the following format: drive, server name, server IP address.

a. Click the drives on which to install the NetWare agent. Each drive must be a 
NetWare drive mapped on the Windows 2000 or Windows NT system. You 
can select drives by clicking one or more autodetected drives from the list or 
by typing the drive letter corresponding to the drive you want to use.

b. Click Next. The Installing Components window is displayed. Subsequent 
screens inform you that the installation is progressing. When installation is 
complete, the Install Complete window is displayed.

9. Click Done. 

10. Customize the FAStT MSJ application and set your security parameters. See 
“Security” on page 15 for details.

Uninstalling FAStT MSJ
You must exit the FAStT MSJ application before uninstalling FAStT MSJ. Make sure 
you uninstall the NetWare agent from the Windows 2000 or Windows NT drive 
mapped to the Novell NetWare server when installing FAStT MSJ.

Perform the following steps to uninstall FAStT MSJ:
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1. Start the FAStT MSJ Uninstaller:

• From a Windows 2000/Windows NT system, click Start -> Programs ->  IBM 
FAStT MSJ -> FAStT MSJ Uninstaller.

• From a Red Hat Linux system:

a. Change to the directory where you installed FAStT MSJ. For example, 
type:

cd /usr

b. Type the following to run the InstallAnywhere Uninstaller:

./FAStT_MSJ_Uninstaller

The InstallAnywhere Uninstaller window is displayed with IBM FAStT Man-
agement Suite Java Vx.x.xx as the program to be uninstalled.

2. Click Uninstall. The InstallAnywhere Uninstaller - Component List window lists 
the components to be uninstalled. A message displays informing you that the 
uninstaller is waiting 30 seconds for the agent to shut down. Wait while the unin-
staller removes the components. The InstallAnywhere Uninstaller - Uninstall Com-
plete window informs you that the uninstall is complete.

3. Click Quit.

4. If any items are not successfully uninstalled, repeat the uninstallation instructions 
to remove them.

5. Restart the system.

Getting started
FAStT MSJ enables you to customize the GUI and agent. After you install FAStT MSJ 
and set your initial parameters, these components activate each time you start the 
application.

Starting FAStT MSJ
This section describes how to start FAStT MSJ on a Windows system and a Linux 
system.

Windows 2000/Windows NT system
On a Windows 2000/Windows NT system, double-click the FAStT MSJ icon on your 
desktop if you selected to create the icon during installation (see Figure 3), or click 
Start -> Programs->  IBM FAStT MSJ -> FAStT MSJ.

Figure 3. FAStT MSJ Icon

The FAStT MSJ main window opens. 

Red Hat Linux system
On a Red Hat Linux system, perform the following steps to start the FAStT MSJ:

1. Ensure that you are in a graphical user environment. 

2. Open a command terminal.
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3. Change to the usr directory in which the IBM FAStT MSJ application is installed 
by typing cd /usr.

4. Type ./FAStT_MSJ. The FAStT MSJ main window opens.

FAStT MSJ main window
The IBM Management Suite Java-HBA View window (hereafter referred to as the 
FAStT MSJ main window) is displayed after you start FAStT MSJ. See Figure 4. 

Figure 4. FAStT MSJ main window

 The window consists of the following sections: 

• Menu bar

• Toolbar

• HBA tree panel

• Tab panel

 

Menu Bar

HBA Tree

Toolbar

Tab Panel
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Chapter 4. Basic features overview

This chapter lists FAStT MSJ features and contains general information needed to run 
FAStT MSJ on any supported platform. Topics include:

• Features

• Options

• Connecting to hosts

• Disconnecting from hosts

• Polling interval

• Security

• Help menu

Features
FAStT MSJ enables you to do the following: 

• Set FAStT MSJ options

• Connect to hosts

• Disconnect from a host

• View extensive event and alarm log information

• Use host-to-host SAN Configuration Policies

• Configure port devices

• Use LUN Level configuration

• Watch real-time to see when failovers occur with the Failover Watcher

• Control host-side agent operations, including setting the host agent polling inter-
val

• Review host adapter information, including:

— General information

— Statistics

— Information on attached devices

— Attached device link status

• Perform adapter functions, including:

— Configure adapter NVRAM settings

— Execute Fibre Diagnostics (Read/Write Loopback tests)

— Perform flash updates on an adapter

— Perform NVRAM updates on an adapter

• Manage configurations

— Save configurations for off-line policy checks and SAN integrity

— Load configurations from file if host is off-line for policy checks and SAN integ-
rity

• Confirm security
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Options
To configure FAStT MSJ, click View -> Options. The options window opens.

Figure 5. Options window

The Options window has four sections and two buttons: 

• Event Log

• Alarm Log

• Warning Displays

• Configuration Change Alarm

• OK (save changes) and Cancel (changes are not saved) buttons

The option window functions are described in the following sections.

 Event log
Event log information includes communication and file system errors. FAStT MSJ 
stores the event entries in the events.txt file. You can log informational and warning 
events. 

You can set the maximum size of the event log to be in the range of 20 to 200 event 
entries; the default is 20 events. When the maximum size of the event log is 
exceeded, old entries are automatically deleted to provide space for new entries. The 
following are example event log entries:

Fri Dec 08 17:10:47 PST 2000, 4, RPC request 23 for Host 10.3.1.152
failed., 2

Fri Dec 08 17:10:47 PST 2000, 4, Retrying RPC request 23
for Host 10.3.1.152., 2
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Fri Dec 08 17:11:32 PST 2000, 4, RPC request 23 for Host 10.3.1.152
failed., 2

 Alarm log
When FAStT MSJ communicates with a host, FAStT MSJ continually receives notifi-
cation messages from the host indicating changes directly or indirectly made on 
adapters. Messages regarding status, configuration, and NVRAM changes are 
logged. FAStT MSJ stores these alarm messages in the alarms.txt file. 

You can set the maximum size of the alarm log to be in the range of 20 to 200 event 
entries; the default is 200 entries. When the maximum size of the alarm log is 
exceeded, old entries are automatically deleted to provide space for new entries. Fol-
lowing are example alarm log entries: 

Mon Dec 04 15:28:03 PST 2000, carlhpc, 2-2100, 0, Status Change: LIP 
Detected., 1

Mon Dec 04 15:28:04 PST 2000, carlhpc, 3-12160, 0, Status Change: Request 
Transfer Error., 1

Mon Dec 04 15:28:33 PST 2000, carlhpc, 0-2200, 0, Status Change: System 
Error., 2

 Warning displays
FAStT MSJ displays additional warning dialogs throughout the application. By default, 
the Warning Displays option is enabled. To disable the display of warning dialogs, 
clear the Enable warning displays check box on the Options window.

 Configuration change alarm
FAStT MSJ tries to keep the devices and the LUNs that the adapter displays current. 
During cable disconnects, hotplug of devices, or device removal, configuration change 
alarms are generated to keep the GUI current. You can control the way FAStT MSJ 
handles configuration change alarms with the Configuration Change Alarm option. 
You can choose from the following options: 

• Apply Configuration Changes Automatically 

When a configuration change alarm is detected by the GUI, the application dis-
connects the host and reconnects to get the new configuration automatically.

• Confirm Configuration Change Applies (default setting)

When a configuration change alarm is detected by the GUI, the application dis-
plays a window that the user clicks Yes or No to refresh the configuration for the 
specified host. See Figure 6.

 

Figure 6. Configuration Change window
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• Ignore Configuration Changes 

With this setting, a configuration change alarm detected by the GUI is ignored. 
For the configuration to be updated, a manual disconnect and connect of the host 
must be performed.

Note: You can refresh the configuration by selecting the desired host and clicking the 
Refresh button on the toolbar or by right-clicking the desired host and clicking 
Refresh on the pop-up menu. 

 Connecting to hosts
There are two ways to connect to hosts in a network: 

• Manually

• Automatically with the Broadcast function

For multi-homed or multiple IP hosts, FAStT MSJ tries to ensure that a specified host 
is not loaded twice into the recognized host tree. If a particular host has multiple inter-
faces (NICs), each with its own IP address, and proper name-resolution-services are 
prepared, the host will not be loaded twice into the tree. Problems can occur when 
one or more IPs are not registered with a host.

The blinking heart indicator (blue pulsating heart icon) indicates that the connection 
between the client and remote agent is active for this test (see Figure 7).

Figure 7. HBA tree with Heartbeat indicator

 

Manual Connection
Perform the following steps to manually connect to a host.

1. From the FAStT MSJ main window click the Connect button, or click Connect 
from the Host menu.

The Connect to Host window is displayed.

2. Type in the host name, or select the host you want to connect to from the drop-
down list. You can use the computer’s IP address or its host name. If the computer 
you want to connect to is the computer on which FAStT MSJ is running, select 
localhost from the drop-down list. To delete all user-entered host names from the 
drop-down list, click Clear. 



 Chapter 4.  Basic features overview  15

3. After you have selected or typed the host’s name, click Connect to initiate the 
connection.

If the connection attempt fails, an error message is displayed that indicates the 
failure and potential causes. If the connection is successfully established, the 
host’s name and its adapters are shown on the HBA tree.

Click Cancel to stop the connection process and return to the main window.

Broadcast connections
FAStT MSJ can auto-connect to all hosts running an agent in a network. For auto-con-
nect to function properly, ensure that the Broadcast setting is enabled. To enable 
auto-connect, select the Auto Connect check box from the Host menu. To disable 
auto-connect, clear the Auto Connect check box. 

Note: If multiple NICs (Network Interface Cards) are present in the system, the 
FAStT MSJ client will broadcast to the first IP address subnet based on the 
binding order. Therefore, ensure that the NIC for the local subnet is first in the 
binding order. If this is not done, the diagnostics might not run properly and 
remote connection might not occur. See the Readme file in the release pack-
age for more information.

 Disconnecting from a host
Perform the following steps to disconnect from a host:

1. From the FAStT MSJ main window HBA tree, click the host that you want to dis-
connect from.

2. Click Host -> Disconnect.

When a host is disconnected, its entry in the HBA tree is removed.

 Polling interval
You can set polling intervals on a per-host basis to retrieve information. The polling 
interval setting can be in the range from 1 second to 3600 seconds (one hour). Per-
form the following steps to set the polling interval:

1. Click the host in the HBA tree in the FAStT MSJ main window.

2. Click Host -> Polling. The Polling Settings - target window is displayed.

3. Type the new polling interval and click OK.

 Security
FAStT MSJ protects everything written to the adapter or adapter configuration with an 
agent-side password. You can set the host agent password from any host that can run 
the FAStT MSJ GUI and connect to the host agent.

When a configuration change is requested, the Security Check window is displayed to 
validate the application-access password. Type the application-access password for 
confirmation.

To change the host agent password, select a host by clicking it in the HBA tree. The 
Information/Security tab panels are displayed. Click the Security tab to display the 
Security panel.
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Figure 8. Security panel

The security panel is divided into two sections: Host Access and Application Access. 

Host access
The Host Access section verifies that the host user login and password has adminis-
trator or root privileges before an application access is attempted. The login and pass-
word values are the same as those used to access the computer.

Login A host user account with administrator or root-level rights.

Password
The password for the host user account.

Application access
The Application Access section enables you to change the FAStT MSJ host agent 
password. To change the password, type information into the following fields: 

Old password
The current application-access password for the host. The original default 
password is config. Change it immediately to a new password.

New password
The new application-access password for the host.

Verify Password
The new application-access password for host verification.

The Help menu
From the FAStT MSJ Help menu, you can specify the location of the browser to 
launch when help is requested by a user. You can also view FAStT MSJ version infor-
mation.

The Help menu contains the following items:
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• Set Browser Location

Click this item to display the Browser Location window (see Figure 9). Type the file 
path of the browser that FAStT MSJ will launch when a user requests help, or click 
Browse to find the file location. 

Figure 9. Browser Location window

• Browse Contents

Click this item to access FAStT MSJ help.

• About

Click this item to view information about FAStT MSJ, including the current FAStT 
MSJ version number.
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Chapter 5. Diagnostics and utilities

The diagnostic and utility features of FAStT MSJ enable you to do the following: 

• View event and alarm log information

• Review host adapter information

— View general information

— View statistics

— View information on attached devices

— View attached device link status

— Configure adapter NVRAM settings

• Perform adapter functions, including:

— Configure adapter NVRAM settings

— Perform NVRAM updates on an adapter

— Perform flash updates on an adapter

— Execute Fibre Diagnostics (Read/Write Loopback tests)

• Manage configurations

— Save configurations for off-line policy checks and SAN integrity

— Load configurations from file if host is off-line for policy checks and SAN integ-
rity

Viewing logs
FAStT MSJ records an extensive set of information to the event and alarm logs. The 
logs are saved as text files (alarms.txt and events.txt) in the folder where FAStT MSJ 
is installed. FAStT MSJ can parse and view these logs in a window. To view these 
logs, click Event Log or Alarm Log from the View menu, or click the appropriate but-
ton on the button bar.

Figure 10. Events and Alarms buttons

Viewing the event log
The event log window displays events relating to FAStT MSJ application operations 
(see Figure 11 on page 20). New events are displayed in the window as they occur. 
There are three types of time-stamped event messages:

•   Informative - an informative or general information event 

•   Warning - a non-critical application event

•   Error - a critical application event
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Figure 11. Event Log window

Click OK to close the Event Log window. Click Clear to purge all event entries from 
the log. 

Sorting
To sort a column in ascending or descending order, right-click the column header, and 
click the desired sorting method.

Details
To view an individual event entry, double-click on the entry; a separate event details 
window is displayed. See Figure 12. You can navigate individual entries by clicking  
Next or Previous.

Figure 12. Event Details window

Viewing alarm log
The alarm log window displays events that occurred on hosts connected to FAStT 
MSJ (see Figure 13 on page 21). New alarms are displayed in the window as they 
occur. Alarm entries have the following properties:

• Time Stamp — The date and time of the logged alarm

• Host Name — The agent host that sent the alarm

• Adapter ID — The host adapter the alarm occurred on

• Application — The type of device that sent the alarm

• Description — The description of the alarm
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Figure 13. Alarm log window

Click OK to close the Alarm Log window. Click Clear to purge all alarm entries from 
the alarm log. 

Sorting
To sort a column in ascending or descending order, right-click the column header, and 
click the desired sorting method.

Colors
When the GUI receives an alarm with a status color other than white (informational), 
the adapter in the HBA tree with the most severe status blinks until you view the 
alarm. The following types of alarms are associated with each color:

• Informational: Rows in the table are color coded white.

• Unknown: Rows in the table are color coded blue.

• Warning: Rows in the table are color coded yellow.

• Bad: Rows in the table are color coded red.

• Loop Down: Adapter in the HBA tree is color coded yellow with a red X (see Fig-
ure 14).

Figure 14. Loop Down alarm in HBA tree
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Details
To view an individual alarm entry, double-click the entry; the Alarm Details window is 
displayed. See Figure 15. You can navigate individual entries by clicking Next and 
Previous.

Figure 15. Alarm Details window

Viewing adapter information
To view adapter information, click the adapter in the HBA tree. The Information panel 
displays general information about the selected adapter (see Figure 16).

Figure 16. Information panel

The Information panel displays the following information:

• Host: The name of the host

• Adapter: The ID of the adapter

• Node Name: The node name of the adapter (WWN)

• Port Name: The port name of the adapter

• Port ID: The port ID of the adapter (the AL-PA if in arbitrated loop environment)

• Serial Number: The serial number (in hex) of the adapter

• BIOS Version: BIOS version of the adapter

• Interrupt Level: The interrupt level the adapter is assigned to

• Driver Version: The version number of the adapter device driver

• Firmware Version: The version number of the adapter firmware
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Viewing adapter statistics
The Statistics panel displays statistical information about the selected adapter (see 
Figure 17).

Figure 17. Statistics panel

The Statistical panel displays the following information:

• Adapter Errors: The number of adapter errors reported by the adapter device 
driver.

• Device Errors: The number of device errors reported by the adapter device driver.

• Reset: The number of LIP resets reported by the adapter device driver.

• I/O Count: The total number of I/Os reported by the adapter device driver.

• IOPS (I/O per second): The current number of I/Os per second.

• BPS (bytes per second): The current number of bytes per second processed by 
the adapter.

Use the buttons and check box at the bottom of the Statistics panel to control sam-
pling:

• Auto Poll

Select this check box to use automatic sampling mode. To use manual mode, 
clear the check box. If the check box is selected, use Set Rate to define the sam-
pling rate. 

• Set Rate

Click Set Rate to set the polling interval at which the GUI retrieves statistics from 
the host. The valid range is 5 to 30 seconds. 

• Update

Click the Update button to retrieve statistics from the host.
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• Reset

Click the Reset button to reset all statistics to the initial value of 0. 

Device list
The Device List panel displays the following information about the devices attached to 
an adapter connected to a host:

• Host: The name of the host

• Adapter: The ID of the adapter

• Node Name: The node name of the adapter (WWN)

• Port Name: The port name of the adapter

• Path: The path number

• Target: The device ID

• Loop ID: The loop ID of the adapter when operating in loop mode

• Port ID: The port ID of the adapter (the AL-PA if in arbitrated loop environment)

• Vendor ID: ID of the device manufacturer

• Product ID: ID of the device

• Product Revision: Device revision level

Figure 18. Device List panel

Link Status
The Link Status panel displays link information for the devices attached to an adapter 
connected to a host.
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Figure 19. Link Status panel

The Link Status table in the panel displays the latest adapter link status from the 
device driver and the status for the adapter and all attached targets.

The first column of the link status table is the World Wide Unique Port Name of the 
adapter and the attached devices.

The remaining columns display the following diagnostics information about the 
adapter and devices (see Table 2).

Use the buttons at the bottom of the panel for the following:

• Refresh Current

Click this button to query the adapter for updated device link statistics since the 
last refresh.

• Refresh Total

Click this button to query the adapter for cumulative updated device link statistics.

• Reset Current

Click this button to initialize link statistics. 

Displaying device information
You can view general device information (see “Viewing general device information” on 
page 26) or a LUN list (see “Viewing the LUN List” on page 26).

Table 2. Link status table. 

Diagnostic information Definition

Link Failure A loss of word synchronization for more than 100 msec 
or loss of signal. 

Sync Loss Four invalid transmission words out of eight (FC-PH 
rules) cause loss of synchronization (synch). Only 
transitions from in sync to out of sync are counted. 
Three valid ordered sets in a row are required to 
reestablish word sync. 

Signal Loss The receiver is not detecting a valid input signal.

Invalid CRC The number of Cyclic Redundancy Check (CRC) errors 
that were detected by the device. 
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Viewing general device information
To view general information about a device, click the device in the FAStT MSJ main 
window HBA tree. The Information panel for the device is displayed. See Figure 20.

Figure 20. Device Information panel

The Information panel displays the following information:

• Vendor: Device manufacturer

• Product ID: Product ID of the device

• Product Rev: Device revision level

• Device Node Name: World wide node name of the device

• Device Port Name: World wide port name of the selected device port

• Device Port ID: Port ID of the selected device port

Viewing the LUN List
To display information about LUNs, click the device in the FAStT MSJ main window 
HBA tree; then, click the LUN List tab. The LUN List window is displayed. See Figure 
21 on page 27.
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Figure 21. LUN List panel

The identifying information is displayed:

• Device Vendor: The device manufacturer

• Device Product ID: The product ID of the device

• Device Product Rev: The device revision level

• Device Node Name: The World wide node name of the device

• Device Port Name: The World wide port name of the selected device port

• Device Port ID: Port ID of the selected device port 

The LUN list information is displayed:

• LUN: The LUN number

• Vendor: The manufacturer of the LUN

• Product ID: The product ID of the LUN

• Product Rev: The product revision level of the LUN

• World Wide Unique LUN Name: The World wide name of the LUN

• Size: The capacity of the LUN

• Disk Number: The disk number of the LUN

Displaying LUN information
To view general information about a LUN, click the LUN in the FAStT MSJ main win-
dow HBA tree; then, click the Information tab. The Information window for the LUN 
is displayed. See Figure 22 on page 28.
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Figure 22. LUN Information panel

The LUN Information panel displays the following information: 

• Vendor: Manufacturer of the LUN

• Product ID: Product ID of the LUN

• Product Rev: Revision level of the LUN

• LUN: LUN number

• World Wide Unique LUN Name: World wide name of the LUN

NVRAM settings
The NVRAM Settings panel displays parameters that are saved in the adapter’s Non-
Volatile RAM (NVRAM).

Note: The NVRAM parameters are preset at the factory. Do not alter them unless an 
IBM technical-support representative instructs you to do so. Adapter operation 
might be adversely affected if you enter the wrong parameters.

The NVRAM settings panel controls settings are divided into three categories: Host 
NVRAM Settings, Advanced NVRAM Settings, and Extended NVRAM Settings. You 
can access sections by clicking an option in the Select NVRAM drop-down list. The 
following sections define the NVRAM parameters and do not necessarily reflect the 
IBM default values. 

Host NVRAM settings
When you click Host NVRAM Settings in the Select NVRAM section list box, the fol-
lowing information is displayed:
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Figure 23. NVRAM Settings panel - Host NVRAM Settings

The following parameters are available in the Host NVRAM Settings section:

Hard Loop ID
ID used by the adapter when the Enable Adapter Hard Loop ID setting is 
enabled.

Frame Size
Specifies the maximum frame length supported by the adapter. The valid 
frame sizes are: 512, 1024, and 2048.

Loop Reset Delay
After resetting the loop, the firmware refrains from initiating any loop activity 
for the number of seconds specified in this setting. The valid delay is 0 to 60 
seconds.

Enable Adapter Hard Loop ID
If this setting is enabled, the adapter uses the ID specified in the Hard Loop 
ID setting.

Enable Host Adapter BIOS
When this setting is disabled, the ROM BIOS on the host bus adapter is dis-
abled, freeing space in the system’s upper memory. Do not disable this set-
ting if you are booting from a Fibre Channel disk drive attached to the adapter.

The Initial button restores all parameters to the settings used when the system was 
initially started. The Current button restores the updated settings modified by FAStT 
MSJ. The Save button saves the updated NVRAM settings. 

Advanced NVRAM settings
When you click Advanced NVRAM Settings in the Select NVRAM section list box, 
the following information is displayed:



 

 30 IBM® FAStT MSJ: User’s Guide  

Figure 24. NVRAM Settings panel - Advanced NVRAM Settings

The following parameters are available in the Advanced NVRAM Settings section:

Execution Throttle
Specifies the maximum number of commands executing on any one port. 
When a port execution throttle is reached, no new commands are executed 
until the current command finishes executing. The valid values for this setting 
are in the range 1 to 256.

Login Retry Count
Specifies the number of retries the adapter uses during a login. This count 
can be a value in the range 0 to 255.

IOCB Allocation
Specifies the maximum number of buffers from the firmware buffer pool to be 
allocated to any one port. Valid range is 1 to 512.

LUNs per Target
Specifies the number of LUNs per target. Multiple LUN support is typical for 
Redundant Array of Independent Disk (RAID) boxes that use LUNs to map 
drives. The valid values for this setting are 0, 8, 16, 32, 64, 128, and 256. If 
you do not need multiple LUN support, set LUNs per Target to 0.

Port Down Retry Count
Specifies the number of times the adapter software retries a command to a 
port returning port down status. Valid range is 0 to 255.

Enable 4GB Addressing
When enabled, the adapter is notified if the system has more than 4 gigabytes 
of memory.

Enable Database Updates
When enabled, the adapter device driver saves loop configuration information 
in the flash (EEPROM) when the system is powered down.

Enable LIP Full Login
When this setting is enabled, the adapter logs in to all ports after a loop initial-
ization process (LIP).
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Enable Drivers Load RISC Code
When this setting is enabled, the host adapter uses the RISC firmware that is 
embedded in the adapter device driver. If this setting is disabled, the adapter 
device driver loads the latest version of RISC firmware found on the system. 

Note: The device driver being loaded must support this setting. If the device 
driver does not support this setting, the result is the same as disabled 
regardless of the setting. Leaving this option enabled ensures support 
of the software device driver and RISC firmware.

Disable Database Load
When enabled, the device database is read from the Registry during device 
driver initialization. When disabled, the device database is created dynami-
cally during device driver initialization. The default value is cleared (Disable 
Database Load is not enabled).

Note: This option usually applies to Windows NT and Windows 2000 operat-
ing environments.

Enable Extended Error Logging
This setting provides additional error and debugging information to the oper-
ating system.

Enable Fast Command Posting
When this setting is enabled, command execution time is decreased by mini-
mizing the number of interrupts.

Enable LIP Reset
This setting determines the type of LIP reset that is used when the operating 
system initiates a bus reset routine. When this setting is enabled, the adapter 
device driver initiates a global LIP reset to clear the target drive reservations. 
When this setting is disabled, the device driver initiates a global LIP reset with 
full login.

Enable Target Reset
When this setting is enabled, the adapter device driver issues a target reset to 
all devices on the loop during a SCSI bus reset function call.

Extended NVRAM settings
When you click Extended NVRAM Settings in the Select NVRAM section list box, 
the following information is displayed: 
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Figure 25. NVRAM Settings panel - Extended NVRAM Settings

The following parameters are available in the Extended NVRAM Settings section:

Operation mode
Specifies the reduced interrupt operation (RIO) modes (see Table 3). RIO 
modes enable posting multiple command completions in a single interrupt.

Connection Options
Defines the type of connection (loop or point-to-point) or connection prefer-
ence during startup (see Table 4 on page 33).

Table 3. Reduced interrupt operation modes. 

Bit Description

0 RIO is disabled; enable fast posting by setting the Fast Posting option.

1 Combine multiple responses, 16-bit handles, interrupt the host. The handles are 
reported by asynchronous event codes 8031h-8035h or the RIO Type 2 IOCB.

2 Combine multiple responses, 32-bit handles, interrupt the host. The handles are 
reported by asynchronous event code 8020h or 8042h or the RIO Type 1 IOCB.

3 Combine multiple responses, 16-bit handles, delay the host interrupt. The 
handles are reported by the RIO Type 2 IOCB

4 Combine multiple responses, 32-bit handles, delay the host interrupt. The 
handles are reported by the RIO Type 1 IOCB.
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Response Timer
Sets the time limit (in 100-microsecond increments) for accumulating multiple 
responses. For example, if this field is 8, the time limit is 800 microseconds.

Interrupt Delay Timer
Sets the time to wait (in 100-microsecond increments) between accessing a 
set of handles and generating an interrupt. (An interrupt is not generated 
when the host updates the queue out-pointer during this period.) For exam-
ple, if this field is set to 4, then 400 microseconds pass between the DMA 
operation and the interrupt.

Enable Extended Control Block
This setting enables all extended NVRAM settings. The default is enabled.

Enable Fibre Channel Confirm
This setting is reserved for Fibre Channel tape support.

Enable Class 2 Service
Select this check box to provide class 2 service parameters during all auto-
matic logins (loop ports). Clear the check box if you do not want to provide 
class 2 service parameters during automatic logins.

Enable ACK0
Select this check box to use ACK0 when class 2 service parameters are 
used. Clear this check box to use ACK1.

Enable Fibre Channel Tape Support
Select this check box to enable the firmware to provide Fibre Channel tape 
support.

Enable Command Reference Number
This setting is reserved. The default is disabled.

Enable Read Transfer Ready
Select this check box to enable the read transfer ready option (XFR-RDY). 
The firmware also sends an XPR-RDY IU before transferring read data as a 
SCSI target.

Utilities
Within the Utilities panel you can perform adapter-level configurations on a host-con-
nected adapter.

Table 4. Connection type and preference. 

Bit Description

0 Loop only

1 Point-to-point only

2 Loop preferred, otherwise point-to-point

3 Point-to-point preferred, otherwise loop
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Figure 26. Utilities panel

Update flash
When you click this button (and the adapter accepts the update), the application 
prompts for the file name that contains the new flash BIOS. You can obtain this file 
from the IBM Web site or service personnel. The file name ends with .BIN (for exam-
ple, QL22ROM.BIN).

After you enter a valid flash file, click OK to proceed with the update, or click Cancel 
to abort.

When you click OK, FAStT MSJ verifies the file name and format of the new file. If the 
file is valid, the application compares the version of the file with the adapter flash ver-
sion. If the adapter version is the same or newer than the file flash version, the appli-
cation asks if you still want to update the flash.

If the update fails, an error message is displayed.

Update NVRAM
When you click this button (and the adapter accepts the update), the application 
prompts for the file name that contains the new NVRAM. You can obtain this file from 
the IBM Web site or service personnel. The file name ends with .DAT (for example, 
NVRM22.DAT).

After you enter a valid NVRAM file, click OK to proceed with the update, or click 
Cancel to abort.

When you click OK, FAStT MSJ verifies the contents of the new file.

If the update fails, an error message is displayed.

Diagnostics
You can perform the loopback and read/write buffer tests using the Diagnostics panel 
(see Figure 27 on page 35).
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Figure 27. Diagnostics panel

The loopback test is internal to the adapter. The test evaluates the Fibre Channel loop 
stability and error rate. The test transmits and receives (loopback) the specified data 
and checks for frame CRC, disparity, and length errors.

The read/write buffer test sends data through the SCSI Write Buffer command to a 
target device, reads the data back through the SCSI Read Buffer command, and com-
pares the data for errors. The test also compares the link status of the device before 
and after the read/write buffer test. If errors occur, the test indicates a broken or unre-
liable link between the adapter and the device.

The Diagnostics panel has three main parts:

• Identifying Information

This part of the panel displays information about the adapter being tested. This 
information includes:

— Host

— Adapter

— Node Name

— Port Name

— Port ID

• Diagnostic Configuration Error

This part of the panel contains the following testing options:

Data Pattern
Sets the test pattern. You can click a data pattern in the list or specify a 
customized pattern.

To specify a customized pattern, click Customized in the list and type the 
data pattern in hex format (0x00 - 0xFF) into the boxes under Custom-
ized. 



 

 36 IBM® FAStT MSJ: User’s Guide  

When you select the random pattern from the list, a new random 8-byte 
pattern is sent to the devices, the adapter, or both (depending on whether 
you select the loopback or read/write buffer test).

Number of test(s)
Sets the number of tests you want to run. You can run the test for a cer-
tain number of times (up to 10,000) or continuously. You can also set the 
number of test increments per test up to 10,000. 

Test continuously
Select this check box to test continuously. 

Test Increment
The Test Increment value determines the number of times a test will be 
run against a particular device (read/write buffer test). For example if the 
value is set to 10, the Read/Write buffer test will be run 10 times against 
that device before moving to the next device in the Device List. The Num-
ber of tests parameter determines the total number of tests that will be 
run.

If you select Test continuously, the Test Increment value is set to 125 as 
the default value. You can increase this value to up to 10,000. While the 
test is running, a test progress dialogue window is displayed. You can 
cancel the test at any time by clicking the Stop button in this window. 
FAStT MSJ waits until the Test Increment value is reached before stop-
ping. Thus, a large Test Increment value will delay the stop action. The 
delay is dependent on the number of devices being tested.

Stop on error
Select this check box if you want continuous testing to discontinue when 
an error is encountered.

 

• Loopback Test Results

The Loopback Test Results section displays the results of a test. The first column 
shows whether the test passed or failed. The remaining columns display error 
counters.

For a loopback test, the test result includes the following information: Test Status, 
CRC Error, Disparity Error, and Frame Length Error.

For a Read/Write Buffer Test, the test result shows the following information: Loop 
ID/Status, Data Miscompare, Link Failure, Sync Loss, Signal Loss, and Invalid 
CRC.

Some devices do not support Read/Write Buffer commands. FAStT MSJ displays 
the result for these devices as Information (blue) with the R/W buffer not sup-
ported message in the Data Miscompare column. The test results are sorted in 
the following order:

1. Errors

2. Information

3. Success

Notes:

1. The Netfinity® Fibre Channel Host Bus Adapter (QLA2100) does not support 
loopback mode. Use only the read/write test for this type of adapter.

2. A wrap connector and coupler (refer to the README file for the part number) 
is available to assist in isolating loop problems. When running the loopback 
test, you can plug the wrap connector directly into the FAStT host bus adapter 
to verify whether the adapter is functional. You can then move the wrap con-
nector to other points in the loop (for example, ends of cables, hubs, and so 
on) to isolate the point of failure.



 Chapter 5.  Diagnostics and utilities  37

3. If the read/write buffer test returns the message The Adapter has no devices 
attached, make sure that the HBA is connected to the devices, and click  
Refresh to refresh the host database. If the adapter detects devices, they will 
appear in the HBA tree of the selected host.

Running the diagnostic tests
After you have chosen the loopback and read/write buffer test parameters as 
described in “Diagnostics” on page 34, click Loopback Test or Read/Write Buffer 
Test to run the loopback or read/write buffer test. If displaying warnings is enabled, 
the following warning window is displayed. 

Figure 28. Diagnostic Loopback and Read/Write Buffer Tests Warning

Click Yes if there are no I/Os active and you want to proceed with the test, or click No 
to cancel the diagnostic test.

Note: To disable the warning message, click View ->  Options, and clear the Enable 
Warning Messages Displays check box.

If you selected the Test continuously check box or a large value for number of tests 
or test increments, the Test Progress Dialogue window is displayed (see Figure 29). 
Click Stop to cancel the test. 

Figure 29. Test Progress Dialogue window

Diagnostic test results
The Test Result section of the Diagnostics panel displays the results of a test (see 
Figure 30 on page 38 and Figure 31 on page 39). Descriptions of the Loopback Test 
Results and Read/Write Test Results sections follow. 
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Loopback test results
The Loopback Test Results section provides the following information: 

• Tests Status—whether the test passed or failed. The possible values are:

— Success—The test passed.

— Error—CRC, disparity, or frame length errors occurred.

— Failed—An error occurred when attempting to issue a command.

— Loop down—The loop is down.

• CRC Error—Number of CRC errors

• Disparity Error—Number of disparity errors

• Frame Length Errors—Number of frame length errors

The Test Status column in Figure 30 shows that the loopback test failed.

Figure 30. Loopback Test Results section

Read/Write Buffer Test Results
The Read/Write Buffer Test Results section provides the following information:

• Loop ID—The loop ID of the adapter when operating in loop mode.

• Status—Whether the test passed or failed. The possible values:

— Success—The test passed.

— Error—A data miscompare or link status firmware error occurred.

— Failed—A link status error, SCSI write buffer error, or SCSI read buffer error 
occurred.

— Unknown—The target was not present.

— Unsupported—The device does not support this test.

• Data Miscompare—Type of data miscompare. The possible values:
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— 0 (no data miscompares)

— Get link status failed

— Read buffer failed

— Reserve unit failed

— Release unit failed

— R/W buffer not supported

— Write buffer failed

• Link Failure—Number of link failures

• Sync Loss—Number of sync loss errors

• Signal Loss—Number of signal loss errors

• Invalid CRC—Number of CRCs that were not valid

Figure 31. Read/Write Buffer Test Results section

 Saving a configuration to a file
You can save a virtual image of a host that has been configured and might no longer 
be connected to the network by saving the host configuration to a file. To load the con-
figuration of the host that has been saved, you must first configure and save the host 
information to a file.

To save the host configuration, click File -> Save Configuration to File in the Host 
Adapter Configuration window.

You are alerted with the following information:
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Figure 32. Save Configuration Alert window

 

After the .qlc file has been saved, the user can load it. 

 Loading a configuration from a file
After you have saved the host configuration to a file, you can load the configuration. 
Loading from a file enables you to load a virtual image of a host that has been previ-
ously configured and that is no longer connected to the network.

To load a configured file from FAStT MSJ, perform the following steps:

1. Click Host -> Load from File in the Host Adapter Configuration window.

2. In the Open window, click the file you want to load, then click Open.

Figure 33. Load Configuration File window

After you have loaded the file, the adapters under the newly loaded host will appear in 
blue in the HBA. Blue adapters indicate that the host was loaded from a file rather 
than a live host.
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Opening a group
Opening the group from a file enables the user to reload all the host information that 
was previously saved by the Save Group operation. FAStT MSJ will then connect the 
host and identify any discrepancies between the saved configuration and the newly 
discovered one.

To open a host configuration, click File -> Open Group in the host adapter configura-
tion window. Select the desired .hst file from the Open window. After the file has been 
opened, the newly loaded host will be connected and displayed in the HBA tree panel.

Saving a group
Saving a Host Group to a file enables the user to save the HBA tree for that host 
including the device list and configuration settings. This feature also allows a system 
administrator to create Host files to selectively connect a number of hosts in the same 
SAN.

To save a host configuration to FAStT MSJ, the host adapter must be configured. Click 
File -> Save Group in the host adapter configuration window.

Once the ’Save Group’ sub-menu item is selected the Save window is displayed. 
Select a file name (for example. Host NodeA.HST) and click Enter.
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Chapter 6. SAN port configuration

This chapter describes the port configuration function of FAStT MSJ and includes the 
following information:

• Configuring Fibre Channel devices

• Configuring LUNs for a device

• Viewing adapter, device, and path information

• Editing persistent configuration data

• Saving and retrieving the host configuration to view from a file

• Using the failover watcher

Note: All of these configuration functions are available for only Linux operating sys-
tems. 

Configuring Fibre Channel devices
Perform the following steps to configure Fibre Channel devices.

1. Do one of the following from the FAStT MSJ main menu.

• In the HBA tree, click the host or an adapter connected to the host. Click Con-
figure on the toolbar.

• Right-click the host or adapter in the HBA tree. From the pop-up menu, click 
Configure. If FAStT MSJ detects an erroneous port configuration, the follow-
ing message is displayed (see Figure 34). Click OK to continue.

Note: You will see this message prior to configuring the ports for the first 
time. 

Figure 34. Port Configuration for Host Name message 

Erroneous port configurations include:

• A device with contradictory visible paths. Only one path can be visible at a 
time.

• A LUN with contradictory (both disabled and enabled) paths. A configuration 
is valid when all paths are either enabled or disabled.

• More than one preferred path in the system. Only one path can be preferred 
at a time.

The Fibre Channel Port Configuration window is displayed (see Figure 35 on 
page 44).
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Figure 35. Fibre Channel Port Configuration window

The host name is displayed in the title bar. The window displays the adapters and 
devices in the computer. The following information is displayed.

• Device Node Name: World wide device node name

• Device Port Name: World wide device port name

• Adapter n (Path/Target/Loop ID): The adapter cell in the table represents a 
path (the device is visible to the adapter)

Adapter cell information consists of the following:

— Path: Path number

— Target: Device ID

— Loop ID: Complement of the arbitrated loop_physical address (AL_PA)

The adapter cells are color-coded to represent path information, as follows:

— White with open eye icon: The path is visible to the operating system.

— Black with no icon: The path is hidden from the operating system.

— Gray with stop icon: The device is unconfigured.

— White with no icon: There is no path present.

2. Select the following, as appropriate, from the Fibre Channel Port Configuration 
window menu.

• Modify the devices, LUNs, and paths:

— Editing persistent configuration data (see “Editing persistent configuration 
data” on page 55)

— Separating and combining separated device ports (see “Separating and 
combining separated device ports” on page 46)

— Auto configuring device paths (see “Automatically configuring device 
paths” on page 46)
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— Configuring LUNs for a device (see “Configuring LUNs for a device” on 
page 48)

— Enabling and disabling LUNs (see “Enabling and disabling all LUNs” on 
page 47)

— Load balancing LUN paths on this host (see “Load balancing LUN paths 
on this host” on page 47)

— Setting device path visibility (see “Setting device path visibility” on page 
47)

• View information:

— Adapter information (see “Viewing adapter information” on page 52)

— Device information (see “Viewing device information” on page 53)

— Help information. Click Help -> Browse Contents. The help text for the 
Fibre Channel Port Configuration window is displayed.

3. The modified configuration set up by FAStT MSJ can be applied to the live system 
for dynamic updates, or can be saved to the system persistent configuration file. 
When you save the configuration, the adapter device driver retrieves the data from 
the persistent configuration file at the next system startup and configures the sys-
tem accordingly.

Do one of the following:

• Click Apply to apply the new configuration. The new configuration is saved to 
the persistent configuration file; it will be used the next time the system is 
restarted. The new configuration remains in memory and is displayed after 
the apply operation completes. If configuration is successful, the following 
message is displayed (see Figure 36). Click OK.

Note: For Linux operating systems, the applied configuration is only effective 
after the device driver is unloaded and subsequently reloaded with 
modprobe.

Figure 36. Apply Configuration message

• Click Save to save the new configuration. The new configuration is saved to 
the persistent configuration file; it will be used the next time the system is 
started. The current configuration remains in memory and is redisplayed after 
the save operation completes.

One of the following messages is displayed:

— If the save was successful, the following message is displayed (see Fig-
ure 37 on page 46). Click OK.
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Figure 37. Save Configuration message

— If the save failed, the Save Configuration Failed message is displayed. 
The failure is usually caused by communication problems between the 
GUI and agent. Click OK.

• Click Cancel on the Fibre Channel Port Configuration window (see Figure 35 
on page 44) if you do not want to save the configuration changes.

Note: For Linux operating systems, the saved configuration is effective after the 
device driver is reloaded. Restarting is not required. 

Separating and combining separated device ports
Failover and currently active paths are usually configured based on the device (as 
represented by the device node name). This method allows for adapter level and port 
failover. You can, however, separate a device into two devices based on a port (by 
device port name), where each device has a subset of paths. This allows only for 
adapter level failover.

Forcing separate devices
Perform the following steps to divide a device with two ports into two distinct devices 
based on the port. Click Edit -> Force Separate Devices, or right-click the device 
node name and click Force Separate Devices.

Combining separated devices
Perform the following steps to combine two devices with the same device node name 
(separated based on their port name) back into one device based on the device node 
name:

1.  Click the device node name in the Fibre Channel Port Configuration window. 

2. Click Edit -> Combine Separated Devices, or right-click the Device Node Name 
and click Combine Separated Devices.

Automatically configuring device paths
The Auto Configure option configures all device paths for the selected host to the 
default values. The default path for each device is the first available path as visible, 
with the other paths hidden. This option prompts for the automatic configuration of 
LUNs associated with these devices.

Perform the following steps to configure the device paths, and optionally the LUN 
paths, on this host to default values.

1. From the Fibre Channel Port Configuration window, click Tools -> Auto Config-
ure. The system prompts whether you also want to use default LUN configura-
tions.

2. Click Yes to change the current LUN configurations to the default values. 
Click No to keep the current LUN configuration settings.
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Enabling and disabling all LUNs
Perform the following steps to configure all LUNs attached to devices on this host as 
enabled or disabled.

1. From the Fibre Channel Port Configuration window, click Tools -> Enable LUNs.

2. Do one of the following:

• Click Enable All to configure all LUNs as enabled.

• Click Disable All to configure all LUNs as disabled.

• Click Inverse State to enable currently disabled LUNs and disable currently 
enabled LUNs.

Load balancing LUN paths on this host
The Load Balance option configures all LUN paths on this host to use system 
resources most efficiently. The LUNs are staggered between the adapters for load dis-
tribution. You can configure all LUNs or only LUNs that are enabled.

Perform the following steps to configure LUNs on this host:

1. From the Fibre Channel Port Configuration window, click Tools  -> Load Balance.

2. Do one of the following:

• Click Enabled LUNs Only to configure only enabled LUNs for load balancing 
across the paths within this device. When you click this option for a device 
with no enabled LUNs, the following message is displayed. Click OK.

Figure 38. Enabled-LUNs Configuration for <hostname> window

• Click All LUNs to configure all LUNs for load balancing across the paths 
within this device.

Setting device path visibility
Perform the following steps to set device path visibility to the operating system.

Note: There must be one visible path for the operating system to see the device.

1. In the Fibre Channel Port Configuration window, right-click the cell in the Adapter 
n column that contains the adapter name.

2. From the pop-up menu, click one of the following options:

• Click Set Visible to set this path as visible to the operating system during the 
start process.

• Click Set Hidden to set this path as not visible to the operating system during 
the start process but used in failover conditions.

• Click Set Unconfigured to set this path as not visible to the operating sys-
tem. The path is not used in failover conditions. If setting the path has caused 
the LUNs associated with this device to have an invalid configuration, an error 
message is displayed (see Figure 39 on page 48).
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Figure 39. Modified Configuration for <hostname> window

This problem is usually the result of changing the configuration state of a 
device. You must modify the LUN configuration for this device before you can 
save or apply the configuration.

Configuring LUNs for a device
Perform the following steps to configure individual LUNs for a selected device:

1. In the Fibre Channel Port Configuration window, right-click the cell in the Device 
Node Name or Device Port Name column that contains the device name.

2. From the pop-up menu, click Configure LUNs. 

• If FAStT MSJ detects an erroneous LUN configuration, the following message 
is displayed (see Figure 40). Click OK to continue.

Figure 40. Detected Invalid LUN Configuration for <hostname> window

Erroneous LUN configurations include:

— A LUN with both enabled and disabled paths. All paths must be either 
enabled or disabled.

— Too many preferred paths in the system. Only one path can be preferred 
at a time.

• If FAStT MSJ detects an erroneous SAN cloud configuration, the following 
message is displayed (see Figure 41).

Figure 41. Detected Invalid SAN Cloud for <hostname> window
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Change this configuration before continuing; FAStT MSJ cannot manage 
erroneous SAN configurations. Click OK to continue.

The LUN Configuration window for the device is displayed (see Figure 42).

Figure 42. LUN Configuration window

The title displays the host name and world wide device node name. The table dis-
plays the following information:

• LUN: LUN number

• Enable: Whether the LUN is enabled

• Device Port Name: World wide device port name

• Adapter n (Path/Target/Loop ID): The adapter cell in the table represents a 
path (the device is visible to the adapter)

Adapter cell information consists of the following:

— Path: Path number

— Target: Device ID

— Loop ID: Loop IDs are 7-bit values that represent the 127 valid

AL_PA addresses.

— Path type: Preferred or Alternate, and Current

The adapter cells are color-coded to represent path information, as follows:

— Cyan with green bull’s-eye: The preferred path to the LUN.

— Yellow with blue bull’s-eye: An alternate path to the LUN.

— Gray with Stop icon: This is an unconfigured device.

— White with no icon: There is no path present.

3. Click the following, as appropriate, from the LUN Configuration window menu:
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• Modify the LUNs and paths for this device:

— Auto configuring LUN paths (see “Automatically configuring LUN paths” 
on page 51)

— Load balancing LUN paths on this device (see “Load balancing LUN 
paths on this device” on page 51)

— Configuring a LUN path using the default (see “Configuring a LUN path 
using the default” on page 51)

— Enabling and disabling all LUNs (see “Enabling and disabling all LUNs” 
on page 47)

— Enabling and disabling individual LUNs (see “Enabling and disabling indi-
vidual LUNs” on page 52)

— Setting LUN path failover (see “Setting LUN path failover” on page 52)

• View information:

— Adapter information (see “Viewing adapter information” on page 52)

— Device information (see “Viewing device information” on page 53)

— Path information (see “Viewing path information” on page 54)

• Help information. Click Help -> Browse Contents. The help text for the LUN 
Configuration window is displayed.

4. Click OK to save the changes until you exit the Fibre Channel Port Configuration 
window; then, review the configuration changes (see Step 3 on page 49). If FAStT 
MSJ detects an erroneous LUN configuration while saving the configuration, the 
Auto LUN Configuration at Exit for <hostname> window is displayed (see Figure 
43).

Figure 43. Auto LUN Configuration at Exit for <hostname> window

Do one of the following:

• Click Yes if you want the software to configure the invalid LUNs with the 
default paths. The following confirmation message is displayed (see Figure 
44). Click OK.

Figure 44. Default LUN Configuration for <hostname> at Exit window

• Click No if you do not want to configure the invalid LUNs. The configuration 
changes you made are not saved.

• Click Cancel if you do not want to apply the configuration changes.
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Automatically configuring LUN paths
The Auto Configure option configures all LUN paths for the selected device to the 
default values. The default path for each LUN is the first available preferred path, with 
the other paths as alternates.

From the LUN Configuration window Tools menu, click Auto Configure to configure 
the LUN paths on this device to the default values.

Load balancing LUN paths on this device
The Load Balance option configures all LUN paths on this device to use system 
resources most efficiently. The LUNs are staggered between the devices to provide 
load distribution. You can configure all LUNs or only LUNs that are enabled.

Perform the following steps to configure the LUNs on this device:

1. From the LUN Configuration window Tools menu, click Load Balance.

2. Do one of the following:

• Click Enabled LUNs Only to configure only those LUNs enabled for load bal-
ancing across the paths within this device. If you clicked this option for a 
device with no enabled LUNs, the following message is displayed. Click OK.

Figure 45. Enabled-LUNs Configuration for <hostname> window

• Click All LUNs to configure all LUNs for load balancing across the paths 
within this device.

Configuring a LUN path using the default
Perform the following steps to configure a LUN paths to the default values for LUN 
failover, with the first configured path as preferred and all other paths as alternate.

Note: This option is available only if the LUN is enabled and there are at least two 
available paths.

1. For the LUN you want to configure, right-click in the LUN, Enable, or Device Port 
Name column.

2. From the pop-up menu, click Configure Path Using Default.

Enabling and disabling all LUNs
Perform the following steps to configure all LUNs attached to this device as either 
enabled or disabled.

1. In the LUN Configuration window, right-click the Enable heading.

2. From the pop-up menu, click one of the following:

• Enable All LUNs to configure all LUNs as enabled

• Disable All LUNs to configure all LUNs as disabled

• Inverse State to enable currently disabled LUNs and disable currently 
enabled LUNs
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Enabling and disabling individual LUNs
To configure a specific LUN as enabled or disabled, in the LUN Configuration window 
Enable column do one of the following:

• Select the Enable check box to configure the LUN as enabled.

• Clear the Enable check box to configure the LUN as disabled.

Setting LUN path failover
Perform the following steps to set a LUN path as the preferred or alternate path in a 
failover condition. You can also click the preferred or alternate path as the currently 
active path.

Perform the following steps to set LUN path failover:

1. In the LUN Configuration window, right-click the cell for the device in the Adapter 
n column

2. From the pop-up menu, click one of the available options.

• Click Set LUN to Preferred to set the alternate path as the preferred path in a 
failover condition.

• Click Set LUN to Alternate to set the preferred path as the alternate path in a 
failover condition.

• Click Set Path to Current to set this preferred or alternate path as the cur-
rently active path.

Notes:

1. You can set the path of an enabled LUN only. A LUN path can be set as either 
preferred or alternate (but not as unconfigured) if the device path is configured as 
hidden or visible.

2. You can use the failover watcher to view the failover settings for a selected host 
and set the preferred or alternate LUN path as the currently active path (see 
“Using the failover watcher” on page 57).

Viewing adapter, device, and path information
You can view adapter, device, and path information in the Fibre Channel Port Configu-
ration and LUN Configuration windows. In the LUN Configuration window, you can 
also view LUN information. See Chapter 5, “Diagnostics and utilities,” on page 19 for 
information about viewing host, adapter, device, and LUN information from the tab 
panel.

Viewing adapter information
Perform the following steps in the Fibre Channel Port Configuration and LUN Configu-
ration windows to view adapter information.

1. Right-click the Adapter n column heading to display information about a specific 
adapter. The Adapter Information window is displayed (see Figure 46 on page 
53).
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Figure 46. Adapter Information window

The following information is displayed:

• Number: Adapter number

• Type: Type of board. 2200 indicates a QLA22xx

• Serial Number: Serial number of the adapter

• Driver Version: Version of the adapter driver on the host that controls the 
adapter

• Firmware Version: Version of the adapter firmware on the host that controls 
the adapter

• BIOS Version: BIOS version on the adapter

• PCI Slot Number: PCI slot number assigned by the host

• Node Name: World wide adapter node name

• Port Name: World wide adapter port name

• Total Number of Devices: Number of devices attached to the adapter

2. Click OK to close the Adapter Information window.

Viewing device information
Perform the following steps in the Fibre Channel Port Configuration and LUN Configu-
ration windows to view device information.

1. To display information for a device node, do one of the following:

• In the Fibre Channel Port Configuration window, right-click a cell in either the 
Device Node Name or Device Port Name column.

• In the LUN Configuration window, right-click a cell in the LUN, Enable, or 
Device Port Name column.

The Device Information window is displayed (see Figure 47 on page 54).
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Figure 47. Device Information window

The following information is displayed:

• Product Identification: Product ID of the device

• Product Vendor: Device manufacturer

• Product Revision: Device revision level

• Path: Path number

• Target: Device number

• LUN: The first LUN attached to the device

• Loop ID: Loop IDs are 7-bit values that represent the 127 valid

AL_PA addresses.

• Port ID: Port ID of the selected device’s port

• Node Name:  Click World wide node name of the device

• Port Name: World wide port name of the selected device’s port

Note: If the Device Node Name was selected, all the device’s port names 
are displayed.

• Number of LUN(s): Number of LUNs attached to the device

2. Click OK to close the Device Information window.

Viewing path information
Perform the following steps to view path information in the LUN Configuration window.

1. Right-click the cell for the device in the Adapter n column. The Path Information 
window is displayed for the path (see Figure 48 on page 55).
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Figure 48. Path Information window

The following information is displayed:

• Device Node Name: World wide node name of the device

• Device Port Name: World wide port name of the selected device’s port

• LUN: LUN number

• Device Port ID: Port ID of the selected device’s port

• Vendor ID: Device manufacturer

• Product ID: Product ID of the device

• Product Revision: Device revision level

• For the Preferred Path and Alternate Path sections:

— Adapter Number: Number of the adapter

— Path ID: Path number

— Target ID: Device ID

2. Click OK to close the Path Information window.

Editing persistent configuration data
When you select Persistent Configuration Data, the current configuration data is 
displayed if a configuration exists. You can do the following:

• Click Adapter Persistent Configuration to delete the persistent configuration 
data for an adapter and its devices and LUNs (see “Deleting adapter persistent 
configuration data”).

• Click Device Persistent Configuration to delete the persistent configuration data 
for a device and its LUNs (see “Deleting device persistent configuration data” on 
page 56).

Deleting adapter persistent configuration data
Perform the following steps to delete the persistent configuration data for an adapter, 
its devices, and LUNs.

1. Do one of the following:
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• From the FAStT MSJ main window, right-click the host or adapter in the HBA 
tree. In the resulting pop-up menu, click Adapter Persistent Configuration 
Data.

• From the Fibre Channel Port Configuration window Adapter menu, click 
Adapter Persistent Configuration Data.

The Fibre Persistent Configuration Editor window is displayed (see Figure 49).

Figure 49. Fibre Persistent Configuration Editor window

For each adapter connected to the host, the current persistent configuration editor 
lists the adapter number and its world wide port name.

2. Do one of the following to delete one or more entries:

• Click the adapter entries that you want to delete.

• Click Delete to remove the entries. 

The Security Check window is displayed. Enter the password, and click OK.

Note: Changes made to the persistent configuration are final. If you do not 
want the changes, reconfigure the host (see “Configuring Fibre Chan-
nel devices” on page 43).

Deleting device persistent configuration data
Perform the following steps to delete the persistent configuration data for a device and 
its LUNs.

1. Do one of the following.

• From the FAStT MSJ main window, right-click the device or LUN in the HBA 
tree. In the resulting pop-up menu, click Device Persistent Configuration 
Data.

• From the Fibre Channel Port Configuration window, click Device -> Device 
Persistent Configuration Data.

The Device Persistent Configuration Editor window is displayed.

For each device connected to the adapter, the current persistent configuration 
editor displays the device number and its world wide port name.

2. Do the following to delete one or more entries:

a. Click the device entries that you want to delete.

b. Click Delete to remove the entries. The Security Check window is displayed.

c. Type the password and click OK.

Note: Changes made to the persistent configuration are final. If you do not 
want the changes, reconfigure the host (see “Configuring Fibre Chan-
nel devices” on page 43).
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Saving and printing the host configuration file
You can save the host configuration file and then view a virtual image of the host. The 
file name includes the host name, date saved, and time saved. See “Saving a configu-
ration to a file” on page 39 for details.

Printing the configuration to a file
Perform the following steps to print a device and LUN configuration.

1. From the FAStT MSJ main window, do one of the following:

a. In the HBA tree, click the host (or adapter connected to the host).

b. Do one of the following:

• Click Configure on the toolbar.

• Right-click the host (or adapter) in the HBA tree. From the resulting pop-
up menu, click Configure.

The Fibre Channel Port Configuration window is displayed. 

2. Click File -> Print.

3. Select the printer and print the configuration.

Using the failover watcher
The failover watcher enables you to view the failover settings for a selected host and 
set a preferred or alternate LUN path as the currently active path.

Note: See “Setting LUN path failover” on page 52 for more information.

Perform the following steps to view or modify the failover information.

1. In the FAStT MSJ main window HBA tree, click the host for which you want to view 
failover information.

2. Do one of the following:

• Click Host -> Current Path.

• Right-click the host in the HBA tree. From the pop-up menu, click Current 
Path. The HBA ViewFailover window is displayed (see Figure 50 on page 58).
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Figure 50. HBA ViewFailover window

The identifying information is displayed:

• Host

The title displays the host name.

The failover information is displayed:

• Node Name

Listing of the devices and LUNs.

— Devices

World wide device port name of the devices.

— LUNs

LUNs are listed under the devices to which they are connected. Includes 
the LUN number and world wide LUN port name.

• Adapters

Lists the adapters connected to the host and specifies their path status:

— Preferred

— Alternate

Path status:

— Green bull’s-eye and Current: currently active

— Gray bull’s-eye: not active

— Red bull’s-eye: preferred path that is not active

3. To set the path of a device as currently active, do the following:

a. Right-click the path status in the Adapter column.

b. In the pop-up menu, click Set Current. The bull’s-eye changes to green and 
the word Current is displayed.
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Appendix A. Getting information, help, and service

If you need help, service, or technical assistance or just want more information about 
IBM products, you will find a wide variety of sources available from IBM to assist you. 
This section contains information about where to go for additional information about 
IBM and IBM products, what to do if you experience a problem with your computer, 
and whom to call for service should it be necessary.

Getting information
Information about your IBM software is available in the documentation. That docu-
mentation includes online books, README files, and help files. In addition, informa-
tion about IBM products is available on the World Wide Web and through the IBM 
Automated Fax System.

Using the World Wide Web
On the World Wide Web, the IBM Web site has up-to-date information about IBM 
products and support. The address for the IBM Personal Computing home page is 
http://www.ibm.com/pc/.

You can find support information for your IBM products at http://www.ibm.com/pc/sup-
port/.

If you click Profile from the support page, you can create a customized support page 
that is specific to your hardware, complete with Frequently Asked Questions, Parts 
Information, Technical Hints and Tips, and Downloadable Files. In addition, you can 
choose to receive e-mail notifications whenever new information becomes available 
about your registered products.

You also can order publications through the IBM Publications Ordering System at 
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi.

Getting information by fax
If you have a touch-tone telephone and access to a fax machine, in the U.S. and Can-
ada, you can receive, by fax, marketing and technical information on many topics, 
including hardware, operating systems, and local area networks (LANs).

You can call the IBM Automated Fax System 24 hours a day, 7 days a week. Follow 
the recorded instructions, and the requested information will be sent to your fax 
machine. In the U.S. and Canada, to access the IBM Automated Fax System, call 1-
800-426-3395.

Getting help and service

If you have a problem with your server product you will find a wide variety of sources 
available to help you.

Using the documentation
Many problems can be solved without outside assistance. If you experience a problem 
with your product, the first place to start is the troubleshooting information in your IBM 
documentation. If you suspect a software problem, see the documentation, including 
README files and online help, that comes with the operating system or application 
program.
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Calling for service
If you have tried to correct the problem yourself and still need help, during the war-
ranty period, you can get help and information by telephone through the IBM Help-
Center®. The following services are available during the warranty period:

• Problem determination - Trained personnel are available to assist you with 
determining if you have a hardware problem and deciding what action is neces-
sary to fix the problem.

• IBM hardware repair - If the problem is determined to be caused by IBM hard-
ware under warranty, trained service personnel are available to provide the appli-
cable level of service.

• Engineering Change management - Occasionally, there might be changes that 
are required after a product has been sold. IBM or your reseller, if authorized by 
IBM, will make selected Engineering Changes (ECs) available that apply to your 
hardware.

The following items are not covered:

• Replacement or use of non-IBM parts or nonwarranted IBM parts. All warranted 
parts contain a 7-character identification in the format IBM FRU XXXXXXX.

• Identification of software problem sources.
• Configuration of BIOS as part of an installation or upgrade.
• Changes, modifications, or upgrades to device drivers.
• Installation and maintenance of network operating systems (NOS).
• Installation and maintenance of application programs.

Refer to your IBM hardware warranty for a full explanation of IBM warranty terms. Be 
sure to retain your proof of purchase to obtain warranty service.

In the U.S. and Canada, these services are available 24 hours a day, 7 days a week. 
In the U.K., these services are available Monday through Friday, from 9:00 a.m. to 
6:00 p.m. 

Note: Response time will vary depending on the number and complexity of incoming 
calls.

In addition, you are eligible for IBM Start Up Support for 90 days after installation. This 
service provides assistance for:

• Setting up your network operating system
• Installing and configuring interface adapters
• Installing and configuring network adapters

Please have the following information ready when you call: 

• Machine type and model
• Serial numbers of your IBM products
• Description of the problem
• Exact wording of any error messages
• Hardware and software configuration information

Phone numbers are subject to change without notice. For the most up-to-date phone 
numbers, go to http://www.ibm.com/pc/support/ and click Support Phone List.

Country Telephone number

Austria Österreich 01-24 592 5901

Belgium - Dutch Belgie 02-210 9820

Belgium - French Belgique 02-210 9800
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In all other countries, contact your IBM reseller or IBM marketing representative.

Purchasing additional services
During and after the warranty period, you can purchase additional services, such as 
support for IBM and non-IBM hardware, operating systems, and application programs; 
network setup and configuration; upgraded or extended hardware repair services; and 
custom installations. Service availability and service name might vary by country.

For more information about these services, contact your IBM marketing representa-
tive.

Canada Toronto only 416-383-3344

Canada Canada - all other 1-800-565-3344

Denmark Danmark 45 20 82 00

Finland Suomi 09-22 931 840

France France 02 38 55 74 50

Germany Deutschland 07032-1549 201

Ireland Ireland 01-815 9202

Italy Italia 02-482 9202

Luxembourg Luxembourg 298-977 5063

Netherlands Nederland 020-514 5770

Norway Norge 23 05 32 40

Portugal Portugal 21-791 51 47

Spain España 91-662 49 16

Sweden Sverige 08-477 4420

Switzerland Schweiz/Suisse/Svizzera 058-333 0900

United Kingdom United Kingdom 01475-555 055

U.S.A. and Puerto Rico U.S.A. and Puerto Rico 1-800-772-2227

Country Telephone number
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Appendix B. Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in 
other countries. Consult your local IBM representative for information on the products 
and services currently available in your area. Any reference to an IBM product, pro-
gram, or service is not intended to state or imply that only that IBM product, program, 
or service may be used. Any functionally equivalent product, program, or service that 
does not infringe any IBM intellectual property right may be used instead. However, it 
is the user’s responsibility to evaluate and verify the operation of any non-IBM prod-
uct, program, or service.

IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not give you any 
license to these patents. You can send license inquiries, in writing, to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLI-
CATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. Some states do not allow disclaimer of express or implied warranties in 
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be incor-
porated in new editions of the publication. IBM may make improvements and/or 
changes in the product(s) and/or the program(s) described in this publication at any 
time without notice.

Any references in this publication to non-IBM Web sites are provided for convenience 
only and do not in any manner serve as an endorsement of those Web sites. The 
materials at those Web sites are not part of the materials for this IBM product, and use 
of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes 
appropriate without incurring any obligation to you.

Edition notice
© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2001. 
All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights — Use, 
duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Con-
tract with IBM Corp.
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Trademarks

The following terms are trademarks of the IBM Corporation in the United States, other 
countries, or both:

Intel, MMX, LANDesk, Pentium, Pentium II Xeon, and Pentium III Xeon are trade-
marks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the 
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trade-
marks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of 
others.

e-business logo HelpCenter

IBM xSeries
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